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Documentation Updates
The title page of this document contains the following identifying information:
l
l
l

Software Version number, which indicates the software version.
Document Release Date, which changes each time the document is updated.
Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to: http://h20230.www2.hp.com/selfsolve/manuals
This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to: http://h20229.www2.hp.com/passport-registration.html
Or click the New users - please register link on the HP Passport login page.
You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.

Support
Visit the HP Software Support Online web site at: http://www.hp.com/go/hpsoftwaresupport
This web site provides contact information and details about the products, services, and support that HP Software offers.
HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your
business. As a valued support customer, you can benefit by using the support web site to:
l
l
l
l

Search for knowledge documents of interest
Submit and track support cases and enhancement requests
Download software patches
Manage support contracts
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l
l
l
l

Look up HP support contacts
Review information about available services
Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:
http://h20229.www2.hp.com/passport-registration.html
To find more information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp
HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables you to explore HP Product Solutions to meet your business
needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is
http://h20230.www2.hp.com/sc/solutions/index.jsp
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Chapter 1: Introduction
HP Virtualization Performance Viewer (HP vPV) is a web-based analysis and visualization tool that
analyzes performance trends of elements in virtualized environments. It enables virtualization
monitoring by providing an overview of the environment, near-real-time and historical data analysis and
triaging using an interactive dashboard. It also enables monitoring for cloud and hypervisor
environments. HP vPV helps you visualize performance data for elements in the context of each other
to rapidly analyze bottlenecks. HP vPV provides performance monitoring, graphing, and reporting in a
single interface.
Key features of HP vPV are as follows:
l

l

l

l

l

Monitor the health and performance of the virtualized environment from Dashboard view.
Triage analysis with the Workbench and capability to trend server utilization across days, weeks,
and a month.
Proactive monitoring of the entities that may cause disruptions in the environment. Use Treemap to
identify and view the problems at a glance.
Analyze the capacity, usage, and allocation trends for various resources in a virtualized
environment.
Right sizing recommendation based on historical resource utilization and reclaiming unused
resources.

l

Analyze the impact of increasing the workload.

l

Determine the impact of adding or deleting resources in your environment.

l

Estimate the future capacity utilization in order to proactively plan your hardware requirements.

l

Group VMs, hosts, and datastores into Business Groups for collective analysis in Treemap,
Workbench, and Forecast.

Conventions Used in this Document
The following conventions are used in this document when referring to the location of files on the HP
Virtualization Performance Viewer (HP vPV) system:
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Convention

Description

Value

<install_dir>

The directory where HP vPV is installed.

On Linux systems, the
installation directory is
/opt/OV.

<data_dir>

The common data directory where data files and
log files related to HP Software products are
stored.

The data directory is
/var/opt/OV.
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During installation, the installer performs the following tasks:
Checks if your system meets the disk space requirements. For information on the disk space, see
"Hardware Requirements".

l

Checks if your system has any other HP software product installed. For example: HP vPV coexists with HP Operations Agent version 11.14.

l

l

Provides a detailed log of the system disk space and other HP software products detected.

l

Provides a list of components installed.
Note: HP vPV supports only x64-bit version of the Linux operating system.

The location of the following files used for HP Operations agent co-existence has been changed:
File Name

Old Location

New Location

Viserver.properties

/var/opt/perf

/var/opt/OV/conf/PV

VILog4j.xml

/var/opt/perf

/var/opt/OV/conf/PV

pvcd.jar

/opt/perf/bin/java

/opt/OV/lbin/PV/java

log4j-1.2.17.jar

/opt/perf/bin/java

/opt/OV/lbin/PV/java

Note:
l

The common jars are moved to /opt/OV/lbin/PV/java. The jars specific to a technology are
part of its SMEPack. For Example: jars required by VMWARE collector are present in the java
folder within the VMWARE SMEPack.
/opt/OV/newconfig/OVPM/smepack/VMWARE/java

l

The configuration file OVPMconfig.ini has become obsolete and is no longer being used.

Hardware Requirements
The minimum hardware requirements for installing HP vPV are:
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Item

Value

CPU

2 vCPU

Memory

4 GB

Disk

66 GB

/opt/

700 MB

/var/opt/OV 50 GB
Installing on a slower system or one with less memory may result in slow performance.
The following table lists the hardware requirements for using HP vPV with the Premium and Express
licenses:

License

vCPU

RAM

Disk Space

Instances
Monitored

Express

2

4 GB

66 GB

2000*

Premium

2

4 GB

66 GB

1000

*HP vPV can monitor more than 2000 instances

by increasing the RAM and CPU. For more
information, see the HP Virtualization Performance Viewer Sizing Guide.

Supported Browsers
The following table lists the web browsers that are required to access HP vPV:
Operating Systems Supported Browsers
Microsoft Windows

Firefox 24 (ESR)
Internet Explorer 10
Internet Explorer 9 (limited support)
Google Chrome (latest version)

Linux

Firefox 24 (ESR)

To view the HP vPV home page, install Adobe® Flash Player 10.2 or above and enable JavaScript
support for the Internet Explorer (IE) or Mozilla Firefox browser by adding HP vPV to your list of Trusted
Sites.
Support Matrix
The following table lists the support matrix for HP vPV:
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Deliverable

Platforms/Versions

Linux Installer

RHEL 6.4 (64-bit), 6.5 (64-bit)
CentOS 6.4 (64-bit), 6.5 (64-bit)
Oracle Enterprise Linux 6.5 (64-bit) (Red Hat compatible kernel)
HP vPV does not support the unbreakable kernel (kernels with a uel/uek suffix).

Virtual appliance

CentOS 6.5
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Versions to HP vPV 2.20
You can upgrade HP vPV to version 2.20 only from versions 2.01 and 2.10. The following table lists the
supported upgrade scenarios:
Upgrade Scenario

Procedure

Upgrade HP vPV from version 2.10 to
version 2.20

You can upgrade to HP vPV 2.20 in the following two
ways:

Upgrade HP vPV from version 2.01 to
version 2.20

l

Upgrading HP vPV using the Installer

l

Upgrading HP vPV using the Virtual Appliance

You can upgrade to HP vPV 2.20 in the following two
ways:
l

Upgrading HP vPV using the Installer

l

Upgrading HP vPV using the Virtual Appliance

Note: You can upgrade HP vPV only from version 2.01 and 2.10 to 2.20. Upgrading HP vPV takes
a significant amount of time. You cannot directly upgrade HP vPV from versions 1.00, 1.10, 1.20,
or 2.00 to version 2.20. Also, make sure that you take a snapshot of HP vPV 2.01 or 2.10 machine
before upgrading to 2.20 as rollback is not supported.

Upgrading HP vPV using the Installer
If you are already having an earlier version of HP vPV installed in your environment and want to
upgrade to version 2.20, you can upgrade using .tar file. Download the .tar file on your local machine
and install HP vPV on the VM.
To install HP vPV on a VM, see "Install HP vPV on Linux Nodes" on page 18.
Note: HP vPV recommends that you restart your system after upgrade. After the restart, you must
start the HP vPV server by running the following command at the command prompt:
pv start
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Upgrading HP vPV using the Virtual Appliance
If you already have an earlier version of HP vPV deployed on the virtual appliance and want to upgrade
to version 2.20, you can do it in the following two ways:
l

"Using CDROM Updates (Using .iso)"

l

"Using Specified Repository (Using .zip)"

Using CDROM Updates (Using .iso)
1. Log on to VMware vSphere Client.
2. In the left tree pane, select the HP vPV machine that is to be upgraded.

3. Click the Connect/disconnect CD/DVD devices of the virtual machine
CD/DVD drive1.

icon. Select

4. Click Connect to ISO image on local disk. Windows Explorer appears.
5. Select the HPPV_VA_2.20.xxx_UPDATE.iso file. Click Open.
6. In the HP vPV interface, click the Settings

icon.

7. Launch the HP vPV Virtual Appliance Management web interface using the Launch vPV Virtual
Appliance Management link.
8. Log on to the HP vPV Virtual Appliance using the username as root. The default password is
vperf*viewer.
9. Click Update tab. The Update Status page appears.
10. Click Settings. The Update Settings page appears.
11. In the Update Repository section, select Use CDROM Updates.
12. Click Status. The Update Status page appears.
13. Click Check Updates. The available updates appear.
14. Select the update and click Install Updates. The upgrade process begins.
15. After the upgrade process is complete, 'HP vPV 2.20 upgrade has been successfully completed.'
message appears.
16. Log on to the HP vPV machine where version 2.20 has been installed.
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17. Go to the command prompt and run the following commands to update the OpenSSL software
used by VMware on the HP vPV machine:
yes | cp -f /usr/lib64/libssl.so.1.0.1e /opt/vmware/lib/libssl.so.0.9.8
yes | cp -f /usr/lib64/libssl.so.1.0.1e

/opt/vmware/lib/libssl.so.0.9.8r

yes | cp -f /usr/lib64/libcrypto.so.1.0.1e /opt/vmware/lib/libcrypto.so.0.9.8
yes | cp -f /usr/lib64/libcrypto.so.1.0.1e /opt/vmware/lib/libcrypto.so.0.9.8r
/etc/init.d/vami-sfcb restart
/etc/init.d/vami-lighttp restart

The OpenSSL software is updated with the latest updates.

Using Specified Repository (Using .zip)
1. Download and unzip HPPV_VA_2.20.xxx_UPDATE.zip in the Web folder at the server (Web or
FTP) location.
2. In the HP vPV interface, click the Settings

icon.

3. Launch the HP vPV Virtual Appliance Management web interface using the using the Launch
vPV Virtual Appliance Management link.
4. Log on to the HP vPV Virtual Appliance using the username as root. The default password is
vperf*viewer.
5. Click Update tab. The Update Status page appears.
6. Click Settings. The Update Settings page appears.
7. In the Update Repository section, select Use Specified Repository.
8. In the Repository URL box, type the server (Web or FTP) location where the update file was
unzipped.
9. In the Username and Password box, type the User name and Password, if any.
10. Click Save Settings.
11. Click Status. The Update Status page appears.
12. Click Check Updates. The available updates appear.
13. Select the update and click Install Updates. The upgrade process begins.
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14. After the upgrade process is complete, 'HP vPV 2.20 upgrade has been successfully completed.'
message appears.
15. Log on to the HP vPV machine where version 2.20 has been installed.
16. Go to the command prompt and run the following commands to update the OpenSSL software
used by VMware on the HP vPV machine:
yes | cp -f /usr/lib64/libssl.so.1.0.1e /opt/vmware/lib/libssl.so.0.9.8
yes | cp -f /usr/lib64/libssl.so.1.0.1e

/opt/vmware/lib/libssl.so.0.9.8r

yes | cp -f /usr/lib64/libcrypto.so.1.0.1e /opt/vmware/lib/libcrypto.so.0.9.8
yes | cp -f /usr/lib64/libcrypto.so.1.0.1e /opt/vmware/lib/libcrypto.so.0.9.8r
/etc/init.d/vami-sfcb restart
/etc/init.d/vami-lighttp restart

The OpenSSL software is updated with the latest updates.
Note: The VAMI web server configuration gets modified while upgrading a previous version of HP
vPV to the latest version. The original configuration gets backed up before the modification. If you
want to revert to the previous VAMI configuration, perform the following steps:
1. Log on to the HP vPV virtual appliance as root.
2. Run the following commands:
cp /opt/vmware/etc/lighttpd/lighttpd.conf.vPV cp
/opt/vmware/etc/lighttpd/lighttpd.conf
/etc/init.d/vami-lighttp restart

Verify the Upgrade
You can verify the upgrade to HP vPV version 2.20 by performing either of the following:
l

l

In the HP vPV interface, go to the Help icon and click About HP vPV. A dialog box appears with
the version information.
Verify the version by running the following command at the command prompt:
pv version
Note: After the upgrade, it is recommended to check the status of HP vPV processes using
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the following command:
/opt/OV/bin/ovc
If any of the processes are not running, run the following command to restart the processes:
pv restart
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The following section details the different methods to install HP vPV:
l

"Deploy the HP vPV Virtual Appliance"

l

"Install HP vPV on Linux Nodes"
Note: HP vPV supports direct upgrade only from version 2.01 and 2.10 to version 2.20.

Open Port Requirements
HP vPV requires the following ports to be open on the firewall:
Port

Protocol

Description

8081

HTTP

To make HP vPV accessible from the remote browser, if
there is a firewall on the system where HP vPV is
installed.

8444

HTTPS

To access HP vPV in Hypertext Transfer Protocol Secure
mode.

5480, 5488, and
5489

HTTPS

To access the Virtual Appliance Management Interface
(VAMI).
If you are not performing HP vPV Virtual Appliance
upgrade, it is recommended to keep the port 5489
disabled.

383

HTTPS

For HP vPV internal communication process.

5433

HTTPS

For HP vPV database requirements (HP Vertica).

443

HTTPS

To ensure data collection from VMware vSphere targets.

5671

HTTPS

To ensure data collection from HP OneView targets.

135

TCP

To ensure data collection from Hyper-V targets. Port
between Windows proxy system and Hyper-V host should
be open on Hyper-V host.

8100

HTTPS

To ensure data collection from SCVMM targets. Port
between Windows proxy system and SCVMM host
should be open on the SCVMM host.
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Port

Protocol

Description

22

SSH

To ensure data collection from KVM and Xen targets.

35357 (Admin), 8774
(Nova)

HTTPS

To ensure data collection from OpenStack targets.

Deploy the HP vPV Virtual Appliance
HP vPV is available as a Virtual Appliance for easy deployment in vCenter. You can use the VMware
vSphere Client user interface to deploy the virtual appliance.
The supported VMware vCenter Server versions are 5.0, 5.1, 5.5, and 6.0.
To deploy the HP vPV virtual appliance, follow these steps:
1. Open VMware vSphere Client.
2. Type the credentials and click Login.
3. Select File > Deploy OVF Template. The Deploy OVF Template window opens.
4. Click Browse to browse to the location where you have saved the HP vPV virtual appliance file.
5. Click Next. The window shows the details of virtual appliance.
6. Click Next. The End User License Agreement details appear.
7. Click Accept and then click Next.
8. Type a name for the virtual appliance in the Name field.
9. Select where to deploy the virtual appliance from the Inventory Location tree. Click Next.
10. Select the host or cluster where you want the virtual appliance to run. Click Next.
11. Select the specific host where to run the virtual appliance. Click Next.
12. Select the storage location where you want to store the virtual machine files. Click Next.
13. Select the disk format in which you want to store the virtual disks. Click Next.
14. Type the required Networking Properties and click Next. The window shows the details of the
deployment.
15. Select the Power on after deployment check box.
16. Click Finish. The deployment task starts. After deployment, the virtual appliance name appears in
the tree in the VMware vSphere Client user interface.
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Note: For more information, see the VMware documentation. The steps are subject to change
based on VMware.
Logging in to the Virtual Appliance
You can log in to the HP vPV Virtual Appliance using the username as root. The default password is
vperf*viewer and it is recommended to change the password after logging in.

Install HP vPV on Linux Nodes
Prerequisites for Linux-Based Installer
Following are the prerequisites for the Installer version of HP vPV:
l

Install Libvirt and all its dependencies on the HP vPV server.
Libvirt is an open source management tool to manage virtualized platforms such as Linux, KVM,
Xen, and so on.
Libvirt can be installed on following versions of the different Linux distributions:
Linux Types

OS Versions

CentOS

6.4 (64-bit)
6.5 (64-bit)

RHEL

6.4 (64-bit)
6.5 (64-bit)

Oracle Enterprise Linux

6.5 (64-bit) (Red Hat compatible kernel)
HP vPV does not support the unbreakable kernel (kernels with a
uel/uek suffix).

l

Install Expect and all its dependencies on the HP vPV server.
Expect is a tool that communicates with interactive programs such as ssh.

l

For HP vPV standalone installation, install latest unixODBC package, if it is not already available.
The unixODBC Driver Manager is an open source ODBC driver manager for providing application
developers predictable APIs to access Datasources.

l

Ensure that the host name assigned to RHEL is a Fully Qualified Domain Name (FQDN) and is
resolvable by DNS. If DNS is not configured in the environment, add the IP address machine name
mapping in the /etc/hosts file.
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l

To install HP vPV, the following runtime libraries and packages are required:
n

n

On x64 systems:
o

glibc-2.3.4-2.36.i686.rpm

o

libgcc-3.4.6-8.i386.rpm

o

libstdc++-3.4.6-8.i386

o

libtool-ltdl-2.2.6-15.5.el6.x86_64.rpm

o

unixODBC-2.2.14-12.el6_3.x86_64.rpm

o

ntpdate-4.2.6p5-1.el6.x86_64.rpm

o

libedit-2.11-4.20080712cvs.1.el6.x86_64.rpm

o

ntp-4.2.6p5-1.el6.x86_64.rpm

o

gdb-7.2-60.el6_4.1.x86_64.rpm (for installing pstack)

o

mcelog-1.0pre3_20120814_2-0.13.el6.x86_64.rpm

o

sysstat-9.0.4-22.el6.x86_64.rpm

To check the packages, use the following command:
rpm -qa | grep -i <packagename>
In this instance, <packagename> is the name of the package to be checked for.

n

C++ runtime:
o

For systems with kernel version 2.6:
/usr/lib/libstdc++.so.5

o

For systems with kernel version 2.6 on Itanium :
/usr/lib/libstdc++.so.6

n

Curses runtime library:
/usr/lib/libncurses.so.5

n

unixODBC runtime library:
/usr/lib64/libodbc.so

n

Make sure that the m4 utility is installed at the path /usr/bin/m4.
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n

n

Set the executable (x) bit for the libvirt library at one of the following paths as appropriate for your
environment:
o

/usr/lib64/libvirt.so

o

/usr/lib64/libvirt.so.0

o

/usr/lib/libvirt.so

o

/usr/lib/libvirt.so.0

To set the timezone, run the following command:
# env | grep TZ
TZ=EST5EDT

Prerequisites for HP Vertica:
l

HP Vertica does not support Logical Volume Manager (LVM) on any drive where database files are
stored. HP vPV installer will exit if /var/opt/OV partition is LVM.

l

Linux Filesystem type must be either ext3 or ext4. All other filesystem types are not supported.

l

HP Vertica does not support SELinux except when SELinux is running in permissive mode.

l

/var/opt/OV partition should have a minimum disk space of 50 GB.

l

l

Swap partition of at least 2 GB or larger is required irrespective of the amount of RAM installed on
the system.
Minimum 1 GB of RAM per logical processor.

For more information on the Pre-requisites for HP Vertica, see HP Vertica Analytic Database
Installation Guide
You can install HP vPV by using any of the following procedures:
l

"Attended Installation"

l

"Unattended Installation"
Note: To install HP vPV on your system, you must log on as root user.

Attended Installation
To install HP vPV through Graphical and command line interface, follow these steps:
Installing HP vPV through Graphical Interface
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To install HP vPV using X11 interface, perform the following tasks:
1. Login as a root user.
2. Download the .tar file. Extract the contents of the .tar file.
3. To start installation, if you want to use the X11 terminal window, export the DISPLAY variable to
point to an X11 terminal type the following command:
export DISPLAY=<IP_Address/system_name>:0.0
where, <IP_Address/system_name> is the IP address or the system name of the X11 terminal.
4. Type the following:
<Directory where the tar file is extracted>/HPPV_2.20.xxx_setup.bin
The HP vPV Installation wizard appears. This window displays an introductory message.
Note: If you are installing HP vPV for the first-time on your Linux system, the
ovinstallparams.ini file containing the installation parameters is created in the system’s
temporary directory. During installation, HP Installer checks for the ovinstallparams.ini
file. If HP Installer detects the ovinstallparams.ini file on your system, a message asking
if you want to reuse the values in the file appears.
n

Click Yes to use the values in the configuration file as default values.

n

Click No to overwrite the existing configuration file.

If HP Installer does not find the file, the system creates the ovinstallparams.ini file with
default values in the temporary directory. To save the ovinstallparams.ini data, copy the
file to an alternate location, before installing other HP products.
5. On the HP vPV Installation wizard, click Next. The License Agreement screen appears.
6. Read the terms of license agreement. To continue with installation, select I accept the terms of
License Agreement option. The installation wizard performs install checks.
7. Click Next. The Pre-Install Summary screen appears. The screen displays the list of components
that will be installed.
Note: If HP vPV version 2.01 or 2.10 is present on the system, you would asked to do a
forced re-installation of already installed component packages.
8. Click Install.
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Note: If the installation fails, you can roll back or quit installation. The Roll Back option
removes the components which are already installed.
Clicking Quit stops the installation, but does not uninstall the components installed till then.
When you start HP vPV installation next time, the Installer prompts you to confirm if you want
to resume the installation or uninstall HP vPV.
9. Click Details tab and expand the components tree to view the list of components.
10. To view the log file on your system, click View Log Files.
11. Click Done to complete the installation.
Note: If the system needs to be restarted, the following message appears after installation is
complete: ‘You may need to restart your system for the configuration changes made to the
system to take effect. Would you like to quit this installation?’.
It is recommended that you restart your system after installation.
Installing HP vPV through Command Line Interface
Note: Localization is not supported when installing HP vPV in console mode. As a result, some
text may be illegible.
To install HP vPV through Command Line interface, follow these steps:
1. Login as a root user.
2. Download the .tar file. Extract the contents of the .tar file.
3. Run the following command:
If you are installing HP vPV on a stand-alone system:
<Directory where the tar file is extracted>/HPPV_2.20.xxx_setup.bin -i console
If you have configured the locale of the system to one of the following languages: English,
Japanese, and Simplified Chinese, the installer prompts you to select the language at the
beginning of the installation. You will have the option of choosing the language to which your
system locale is set. If the system locale is set to any other language apart from these, the
installer displays only ‘English’.
4. When the prompt, I accept the terms of the License Agreement for the License information
appears, type Y to accept the terms and continue installation. The installer checks all the Install
Requirements.
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5. Click Enter to continue. The pre-installation summary appears.
Note: If HP vPV version 2.01 or 2.10 is present on the system, you would asked to do a
forced re-installation of already installed component packages. Select Yes to continue.
6. Click Enter to continue.
When the installation is complete, you will receive a message which states that the installation
was completed successfully.

Unattended Installation
To perform unattended installation, follow these steps:
1. Login as a root user.
2. Download the .tar file. Extract the contents of the .tar file.
3. Go to the directory where the .tar file is extracted.
4. Type the following syntax at the command prompt:
./HPPV_2.20.xxx_setup.bin -i silent
Note: If the installer finds a working installation of HP vPV, it will uninstall HP vPV when you
run the -i silent command. If not, it will install HP vPV.
5. To verify the installation, check the log files.
You can view the HP vPV installer log file at /tmp/HPOvInstaller/HPPVInstallLog.txt

Verify the Installation
On successful installation:
l

The Linux systems display the application directory and data directory paths.

l

To view install log files see the following:
For Linux: /tmp/HPPV_2.xx.xxx_HPPVInstaller.txt
/var/tmp/HPOvInstaller/PerfUtil-mm-dd-yyyy.log.0
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In this instance, mm indicates the month, dd indicates the day, and yyyy indicates the year. The file
name indicates the time stamp when the install was performed.
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Chapter 5: Getting Started
After installing HP vPV, you can start using the product by accessing the user interface. To launch HP
vPV, you can use the following URL:
https://<system_name>:<port>/PV
In this instance,
systemname is the IP address or host name of the machine on which HP vPV is configured.
port is port number on which HP vPV is configured. The default port number is 8444.
PV is case sensitive.
Note: If you access HP vPV using the HTTP protocol ( http://<systemname>:<port>/PV), you
are automatically redirected to the secure HP vPV URL (https://<systemname>:<port>/PV).
If authentication is enabled, log in using the user name and password. The Admin page opens for the
first time.
To start using the product, add the data sources to be monitored. For more information on adding data
sources, see the HP Virtualization Performance Viewer Online Help.
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The following section details different methods to configure HP vPV:
l

Configure Secure Communication with Tomcat Server

l

Add a vCenter server running on a non-default port

Configure Secure Communication with Tomcat Server
The HTTPS protocol is by default enabled for HP vPV. The default port number for HTTPS is 8444. To
access HP vPV in the secure mode, use the following URL:
https://<systemname>:8444/PV
You can also change the default port settings for HTTPS communications.
Changing Port Settings
The default HTTPS port number to access HP vPV is 8444. All client systems are authorized to
connect to HP vPV server. To change the default port number for the HP vPV server, follow these
steps:
1. Check for the availability of the port number you want to use, by running the following commands
at the command prompt:
cd <bin_dir>
ovtomcatbctl -checkport <portnumber>
A message indicating if the port is available or in use appears. For example, if you are checking for
the availability of the port number 8444, the message, “Port Number 8444 is not in use” appears, if
the port number is available. If the Port Number 8444 is not available, a message indicating that the
port number is used by another program or service appears.
2. Stop HP vPV by running the following command at the command prompt:
pv stop
3. To change https port numbers for HP vPV server, run the following command at the command
prompt:
cd <bin_dir>
ovconfchg -ns NONOV.TomcatB -set HTTPPort <port number>
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ovconfchg -ns NONOV.TomcatB -set HTTPSPort <port number>
4. Start the HP vPV server by running the following command at the command prompt:
pv start
Using SSL or HTTPS with the Tomcat Web Server
To use SSL or HTTPS protocols with the Tomcat web server, you need to obtain a server certificate for
Tomcat after installing HP vPV. You can replace the certificate obtained after HP vPV installation in
the following scenarios:
l

l

l

When you connect to HP vPV using HTTPS protocol, the certificate and name of the system are
compared to ensure that the names match. If the names are not similar, most browsers alert the
users so that they can decide to either continue or cancel the connection. If the name used by
HTTPS users is different from the name used by the HP vPV installation, you must obtain a
different certificate.
You may need to obtain a new certificate when you want to fill the fields in the certificate that are left
blank during HP vPV installation. The certificate contains many fields to provide information, such
as, the issuer of the certificate and other fields that warrant the safety provided by the certificate.
The HP vPV installation certificate leaves most of these fields blank.
When you want to change the default certificate password to avoid unauthorized changes, you
must replace the existing certificate.

To replace the Tomcat SSL certificate, perform the following steps:
1. Delete the existing certificate by running the following command at the command prompt.
keytool -delete -alias ovtomcatb -keystore /var/opt/OV/certificates/tomcat/b/tomcat.keystore
The keytool path on Linux is /opt/OV/nonOV/jre/b/bin
Note: The password for deleting the certificate is changeit.
2. Restart HP vPV.
3. Create a new certificate. To create a new certificate, run Keytool by entering the following
commands at the command prompt:
keytool -genkey -alias ovtomcatb -keyalg RSA -keystore
/var/opt/OV/certificates/tomcat/b/tomcat.keystore
4. Restart HP vPV.
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Add a vCenter server running on a non-default port
vCenter Server system requires port 443, for connections from the vSphere and Software Development
Kit (SDK) clients. By default, vCenter collector of HP vPV 2.20 uses port 443 for data collection from
vCenter server. If this default port 443 is re-configured in your environment due to any reason, it is
recommended to use the iptables to route the traffic.
During the HP vPV 2.20 installation, run the iptables command and setup port forwarding rules for
each of the target.
Follow the steps:
1. Log on as a root user.
2. Run the following command:
iptables -t nat -A OUTPUT -p tcp -m tcp -d <target vcenter(s) ip> --dport 443 j DNAT --to-destination <target vcenter(s) ip>:<target port>
In this instance, <target vcenter(s) ip> is the ip address of the target vCenter and <target port>
is the port number of the target.

Using HP vPV Commands
After you install HP vPV, you can use the following commands to administer the HP vPV workspace
through the command prompt.
<bin_dir>/pv <Options>
You can replace <Options> with any of the following variables:
l

status - To check the HP vPV status.

l

start - To start HP vPV.
All the applications that use OvTomcatB are started when you run pv start command.

l

stop - To stop HP vPV.
All the applications that use OvTomcatB are stopped when you run pv stop command.

l

restart - To stop and then start HP vPV.

l

trace on - To start generating detailed trace files.
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l

trace off - To stop generating detailed trace files.

l

version - To display the version of HP vPV installed on your system.

Configuring HP vPV to Communicate with Remote HP
Vertica
You can configure HP Virtualization Performance Viewer to communicate with a remote instance of HP
Vertica.
Follow these steps to configure HP Virtualization Performance Viewer to communicate with a remote
instance of HP Vertica.
On the machine where a database instance of HP vPV is to be created:
1. To create a database instance login to HP Vertica system, run the following command:
su <dbadminuser> -c "/opt/vertica/bin/adminTools -t create_db -s <hostname> -d
pv -c <Vertica_DB_Path>/catalog -D <Vertica_DB_Path>/data"
In this instance,
the dbadminuser is the database administrator user.
the hostname is the host name or IP address of HP Vertica system.
the Vertica_DB_Path is the database path of HP Vertica.
For example, su dbadmin -c "/opt/vertica/bin/adminTools -t create_db -s
10.20.10.1 -d pv -c /vertica_disk/catalog -D /vertica_disk/data"
2. Create HP Vertica user. Run the following commands in sequence to create HP Vertica user with
access to public schema:
o

su <dbadminuser> /opt/vertica/bin/vsql –c “CREATE USER <UserName>
IDENTIFIED BY '<Userpassword>'”

o

su <dbadminuser> /opt/vertica/bin/vsql –c “GRANT ALL ON SCHEMA PUBLIC to
<UserName>”

In this instance,
the dbadminuser is the database administrator user.
the UserName is the user name for the database instance.
the Userpassword is the password for database instance.
On HP vPV system:
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1. Log on as root user.
2. Run the following command to stop ovtomcatB and pvcd processes:
/opt/OV/bin/ovc -stop
3. Run the following command to stop the local HP Vertica instance:
/opt/OV/bin/pv_vertica stop
4. Go to /var/opt/OV/conf/perf/
5. Open the PVHibernate.props file. Edit the following attributes in PVHibernate.props file:
a. Set hibernate.connection.url = jdbc:vertica://<IP Address>:<Port Number>/pv
In this instance,
the IP Address is the IP address of remote HP Vertica instance
Note: If HP Vertica is installed on a cluster, the IP Address is the virtual IP address of
the respective cluster.
the Port Number is the port number of remote HP Vertica instance.
b. Set hibernate.connection.username=<User Name>
In this instance,
the User Name is the user name of remote HP Vertica instance.
c. Set hibernate.connection.password=<Password>
In this instance,
the Password is the encrypted password of remote HP Vertica instance.
Note: To get the encrypted password, run the following command:
pvconfig -en <password>
In this instance, password is the decrypted password of remote HP Vertica instance.

6. Run the following commands to update the user name, password, and connection string in the
configuration database:
a. ovconfchg -ns pvcd.dml -set username "<User Name>"
In this instance,
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the User Name is the user name of remote HP Vertica instance.
b. ovconfchg -ns pvcd.dml -set password "<Password>"
In this instance,
the Password is the encrypted password of remote HP Vertica instance.
Note: To get the encrypted password, run the following command:
pvconfig -en <password>
In this instance, password is the decrypted password of remote HP Vertica instance.

c. ovconfchg -ns pvcd.dml -set ConnectionString "DSN=Vertica;SERVERNAME=<IP
Address>;PORT=<Port Number>;"
In this instance,
the IP Address is the IP address of remote HP Vertica instance
Note: If HP Vertica is installed on a cluster, the IP Address is the virtual IP address of
the respective cluster.
the Port Number is the port number of remote HP Vertica instance.
7. Run the following commands in sequence to create database schema on HP vPV system:
o

/opt/OV/bin/pvsql -f /opt/OV/newconfig/OVPM/vertica/CreateTables_Vertica.sql

o

/opt/OV/bin/pvsql -f /opt/OV/newconfig/OVPM/vertica/DummyData_Vertica.sql

o

/opt/OV/bin/pvsql -f
/opt/OV/newconfig/DataDir/conf/PV/Model/DMLMetaMetaSchema

o

/opt/OV/bin/pvsql -f /var/opt/perf/syspulse/scripts/createtable.sql

o

/opt/OV/bin/pvsql -f /opt/OV/newconfig/OVPM/vertica/Create_Custom_
Projections.sql

8. Run the following command to start HP vPV processes:
• /opt/OV/bin/pvconfig –um
• /opt/OV/bin/ovc –start
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After you install HP vPV, you can purchase the appropriate licenses based on your business
requirements. These licenses enable you to access all the features of the product. To purchase the
respective license, click You have Evaluation/Community license. Click to buy license link. The
link navigates to the Buy License page. Enter your details in the Contact Me tab and click Submit.
Make sure email client is configured in your browser.
To access the License option on the HP vPV user interface:
1. Log on to the HP vPV user interface.
2. Click the Settings icon.
The Settings page appears.
3. In the Settings page, click the License option.
The License page appears.
The License page provides information about your HP vPV licenses. You can also use this tab to start
using your Evaluation License as well as import a HP vPV license. For more information on importing
licenses, see "Importing Licenses".
Note: If you install an Express license on the HP vPV server which uses a Community license,
then the Express license overrides the Community license.
If you want to retain the Community license, create a separate HP vPV server to install the
Express license.
For more information on the difference between the licenses and the features available, see "Types of
Licenses"

User Interface
The following table lists the sections available in the License option.
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Section

Description

License
Status

The License Status section lists the following information about your current HP vPV
license:
l

Maximum number of OS instances that are provided by the active licenses

l

Number of OS instances that are currently being monitored by the active licenses

l

Data Retention

l

l

Installed
License
List

If you have a Server Instance License enabled, you can see the total Server Instance
capacity, the current Server Instance Count, and the OS instances that are covered
by the Server license.
License alert threshold

The Installed Licenses List section lists the following information regarding the active and
all installed licenses for HP vPV.
l

Type of license installed

l

Date of license expiry

Note: The number of OS instances denote only the VMs and hosts.

Types of Licenses
HP vPV offers the following licenses: Community, Express, Premium, Evaluation, Monitoring Only,
and Server Instance Licenses.
Note: The maximum number of OS instances that can be monitored by a Community license is
25. The number of OS instances denote only the VMs and hosts. HP vPV recommends monitoring
up to 10,000 OS instances using Express, Premium, and Evaluation license. However, larger
configurations can be supported. For more information, see the HP vPV Sizing Guide. The
Monitoring Only license supports unlimited number of OS instances.
The following table lists the available features for the HP vPV Licenses:

Feature

Communit
y License

Express
License

Premium
License

Evaluatio
n License

Monitorin
g License

Server
License

Data
Retention

Up to 24
hours

90 days

90 days

60 days

8 Days

90 days
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Feature

Communit
y License

Express
License

Premium
License

Evaluatio
n License

Monitorin
g License

Server
License

Perpetual

Perpetu
al

License
Entitlement
Period

Perpetual

Perpetual/Ter
m

Perpetual/Ter
m

60 days

Enterprise
Directory
Integration

No

Yes

Yes

Yes

No

Yes

Reports

Yes

Yes

Yes

Yes

No

Yes

HP OM, HP
OMi, HP PM
and HP BSM
Integration

No

Yes

Yes

Yes

Yes

Yes

Monitoring

No

Yes

Yes

Yes

Yes

Yes

HP CSA
Integration

No

No

Yes

Yes

No

Yes

Business
Grouping

No

No

Yes

Yes

No

Yes

HP OneView
Integration

No

No

Yes

Yes

No

Yes

Monitoring
Physical
Servers

No

No

Yes

Yes

No

Yes

Guest
Operating
System drill
down for
advanced
troubleshootin
g

No

No

Yes

Yes

No

Yes

Current
Capacity
Reports (Only
for VMware™
vSphere,
Microsoft™
HyperV, and
KVM)

No

No

Yes

Yes

No

Yes

HP Virtualization Performance Viewer (2.20)

Page 34 of 58

Installation Guide
Chapter 7: License Management

Feature

Communit
y License

Express
License

Premium
License

Evaluatio
n License

Monitorin
g License

Server
License

Best-fit
Capacity
Optimization
(Only for
VMware™
vSphere,
Microsoft™
HyperV, and
KVM)

No

No

Yes

Yes

No

Yes

Virtual
Machine
Placement
(Only for
VMware™
vSphere,
Microsoft™
HyperV, and
KVM )

No

No

Yes

Yes

No

Yes

Capacity
Demand
Forecast
(Only for
VMware™
vSphere,
Microsoft™
HyperV, and
KVM)

No

No

Yes

Yes

No

Yes

Alerting (Only
for VMware™
vSphere,
Hyper-V, and
KVM)

No

Yes

Yes

Yes

No

Yes

Capacity
Modeler (Only
for VMware™
vSphere, and
KVM)

No

No

Yes

Yes

No

Yes

Dashboard

No

No

Yes

Yes

No

Yes

Note: The number of OS instances denote only the VMs and hosts.
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All product features are available for the Evaluation License. The only difference between the
Evaluation License and Premium License is the validity.
Evaluation License
After installing HP vPV, by default, your active license will be Community License. To start using HP
vPV in evaluation mode, click Start Evaluation. The page refreshes and displays information regarding
your Evaluation License.
After the Evaluation License expires (after 60 days), the system changes your license automatically to
Community License.
You can enable the Evaluation License from the user interface and from the command line.
From User Interface:
To enable Evaluation License from the user interface, follow these steps:
1. Go to the License option in the Settings page.
2. Click the Start Evaluation link.
From Command Line:
To enable Evaluation License from the command line, follow these steps:
1. On the HP vPV machine, log on as a root user.
2. Run the following command to activate the Evaluation license:
pv starteval
Note: Data collection works only when the sum of instances from all data sources is less than or
equal to the maximum instance capacity of the license. If the total instance count exceeds the
maximum instance capacity of the license, then the data collection stops for all the data sources.
For example, if you install a Premium license for 100 instances, and try to connect two hosts with
60 instances each, then the collection fails for both the hosts.
Monitoring Only License
When HP vPV is integrated with HP Operations Manager/HP Operations Manager i (HPOM/OMi) and
you want to use HP vPV's monitoring capabilities only, you can enable the Monitoring Only License.
With the Monitoring Only license, you can only use limited set of features in the Settings option of HP
vPV. All the other HP vPV features are disabled.
You can enable the Monitoring License from the user interface and from the command line.
From User Interface:
To enable Monitoring License from the user interface, follow these steps:
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1. Go to the License option in the Settings page.
2. Click the Start Monitoring Only link.
From Command Line:
To enable Monitoring License from the command line, follow these steps:
1. On the HP vPV machine, log on as a root user.
2. Run the following command to activate the Monitoring Only license:
pv startmonitoringonly
The Evaluation, Premium, and Express licenses override the existing Monitoring license. After the end
of respective license entitlement periods, HP vPV reverts to the Monitoring license features.
Similarly, if you are currently using HP vPV in evaluation mode, and you enable the Monitoring License,
all the features would be available only for the evaluation period. After the Evaluation license validity
expires, the Monitoring license continues to be active.
Server License
You can enable the HP vPV Server license to monitor the servers managed by HP OneView. A single
Server license instance enables you to monitor all the OS instances running on the server covered by
the Server license. A Server license is similar to the Premium license in terms of feature availability.
Note: The maximum number of valid Server instance licenses cannot exceed the maximum
servers managed by HP OneView.
The following table summarizes the behavior of HP vPV in the following license scenarios:
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Currently Active License

License Applied

Community/Evaluation/Monitoring Server License
Only/Express

Behavior
The Server license
overrides the existing
license. The total
licensed instance count
equals the OS
instances covered by
the Server license.
Note: The data
collection will stop
if there are OS
instances that are
running on the
servers not
covered by the
Server license. To
start the data
collection, you can
install additional
licenses with
sufficient capacity.
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Currently Active License

License Applied

Behavior

Premium

Server License

The Server license coexists with the
Premium license. The
total licensed instance
count equals the OS
instances covered by
the Premium and
Server license.
Note: The OS
instances that are
running on the
servers covered by
the Server license
will be deducted
from the current
OS instance count.
This results in
additional OS
instance capacity.

Server License

Premium

The Server license coexists with the
Premium license. The
total licensed instance
count equals the OS
instances covered by
the Premium and
Server license.

Server License

Community/Evaluation/Monitoring
Only/Express

Not supported.

Note: If the number of servers managed by HP OneView exceeds the Server license capacity, the
servers are chosen based on the number of instances associated with them. The servers having
the highest number of instances are automatically selected to be monitored by the Server license.

Importing Licenses
After you purchase a license, you must import it before you start using HP vPV.
To import licenses for HP vPV, follow these steps:
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1. Go to the License option in the Settings page.
2. In the License Status section, click the Import License link.
The Manage License page appears.
3. Type your license key in the License Key field of the Manage License section.
4. Click Import License. The Installed License List section refreshes to display the details of the
license imported.
To clear the license key typed in, click Reset.
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You can remove HP vPV installed on Linux systems by using the procedure described in the following
section:

HP vPV Virtual Appliance
To remove the HP vPV virtual appliance, power off the VM and delete the VM.

Remove HP vPV from Linux Nodes
To remove HP vPV from a Linux system:
1. Log on as root user.
2. Go to /opt/OV/Uninstall/HPPV.
3. Run the uninstall command:
n

To use an X11 interface, export the DISPLAY variable to point to an X11 terminal if necessary.
Then run the command:
./setup.bin

n

To use a command line interface, run the command:
./setup.bin -i console

4. Select Uninstall.

Removing Configurations and User Graph Templates
Removing HP vPV does not remove configurations or user graph templates. You need to manually
remove the files from the data directory.

Removing HP vPV Files using the Clean-up Script
After removing HP vPV, you must run the following clean-up script. This script is available in the
<install_dir>\support:
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clnup_pv.sh for Linux

l

The clean-up script removes the following files from <data_dir>\conf\perf:
l

PVconfig.ini

l

OVPMUsers.xml

l

OVPMSystems.xml

l

ovpm.tcf

l

VPI_GraphsUserFavorites.txt

l

OVPMReportTemplate.htm

l

All folders starting with the name "VPI_".

l

All PV database related files
Note: If you plan to reinstall HP vPV on the same system, make sure you delete the following
folders after you finish running the clean-up script:
l

/opt/OV/

l

/opt/vertica/

l

/var/opt/OV/
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The following section details how to troubleshoot HP vPV:
Vertica database is filled to near capacity due to the increase in the log file size.
Symptom

The Vertica database is filled to near capacity due to the increase in the log file size.

Causes

Vertica database consolidates and retains the log data in a .gz file daily. By default, this
process (called ‘rotate’) continues for 52 weeks.

Resolution To create more space on the Vertica database implement any one of the two solutions
below:
Solution 1
1. Go to /opt/vertica/config/logrotate/.
2. Open the pv file.
3. In the pv file, under # and keep for 52 weeks change the value of rotate from 52
to the number of weeks for which you want to save the rotated log files.
For example: rotate 3
In this instance, the Vertica database will retain the .gz files for 3 weeks.
4. Repeat step 3 for all instances of # and keep for 52 weeks.
5. Save and close the file.
Solution 2
1. Login as a root user.
2. Run the following commands on the HP vPV server:
cd /opt/vertica/bin
./admintools -t logrotate -d pv -r weekly -k <number_of_weeks>
where, <number_of_weeks> is the number of weeks for which you want to retain
the rotated logs.
Unable to Access HP vPV
Symptom

Unable to access HP vPV through the default network port settings.
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Causes

l

l

Resolution

l

l

Your system has ovTomcatB configured to run with the non-root user or non-local
system account privileges and you have HP vPV installed on such a system.
You cannot access HP vPV using the default http (8081) or https (8444) ports if
these ports are in use by other applications.
Check if ovTomcatB is configured to run with the non-root user or non-local system
account privileges. If so, modify the settings to run ovTomcatB with the
Administrator or root user privileges.
Try accessing HP vPV by using the following URL:
http://<IP address/system name>:<port number>/PV
where, <IP address/system name> is the IP address or the system name of the HP
vPV server and <port number> is the port number of the HP vPV server.
If the HP vPV Home page does not appear, check if the default ports are in use.

l

To change the port settings, follow these steps:

1. Run the following command at the command prompt to change the port numbers
for HTTP, HTTPS, and ShutdownPorts:
<bin_dir>ovconfchg -ns NONOV.TomcatB -set HTTPPort <port number>
<bin_dir>ovconfchg -ns NONOV.TomcatB -set HTTPSPort <port number>
<bin_dir>ovconfchg -ns NONOV.TomcatB -set ShutdownPort <port number>
2. Restart HP vPV.
Unable to connect to HP vPV server through HTTPS protocol
Symptom

HP vPV is unable to connect to the server through secure communication (HTTPS)
protocol.

Cause

The connection times out when HP vPV is not able to connect through the secure client
in the default timeout interval of one second.

Resolution Use the parameter SECURE_CLIENT_CONNECT_TIMEOUT to adjust the timeout
interval to connect to HP vPV server depending on your Internet connectivity or
infrastructure setup.
Deployment of HP vPV fails
Symptom

The deployment of the HP vPV Virtual Appliance fails.

Cause

This may happen when the time on the ESX server is set to a future time.

Resolution Ensure that the time on the ESX server is set correctly.
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Unable to view content on HP vPV home page
Symptom

The HP vPV Home page does not display anything except the header.

Cause

JavaScript is not supported or Adobe® Flash Player is not installed in your browser.
Adobe® Flash Player version 10.3 is the minimum required version.

Resolution Install Adobe® Flash Player and enable JavaScript support for the Internet Explorer (IE)
or Mozilla Firefox browser by adding HP vPV to your list of Trusted Sites.
l

To add HP vPV Web server URL to a trusted site, perform the following steps:
For IE browser
a. From the Tools menu, click Internet Options. The Internet Options pop-up
window appears.
b. Click Security tab.
c. Select the Trusted Sites icon.
d. Click Sites. The Trusted Sites pop-up window appears.
e. Type the HP vPV web server URL and click Add. The typed URL appears in the
list of trusted sites.
f. Click Close.
g. Click OK.
h. Restart the browser.
For Mozilla Firefox browser
a. From the Edit menu, click Preferences. The Options pop-up window appears.
b. Click Privacy tab.
c. Click Exceptions.
d. Type the HP vPV web server URL in the box under Address of web site.
e. Click Allow.
f. Click Close.
g. Click OK.
h. Restart the browser.
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Resolution

l

l

If Adobe® Flash Player is not installed in your browser, HP vPV Home page does
not appear. The browser displays a message stating that you must Install Adobe
Flash Player to view the HP vPV Home Page. Click the message to download
Adobe® Flash Player.
If JavaScript is not enabled in your browser, HP vPV Home page does not appear in
the IE browser even after adding it as a trusted site. The browser displays a
message stating that JavaScript is not enabled in your browser and you must
enable JavaScript to view the page.
To enable JavaScript support, perform the following steps:
For IE browser
a. From the Tools menu, click Internet Options. The Internet Options pop-up
window appears.
b. Click the Security tab. Check if the security level in your browser settings is set
to High.
c. Make sure the Trusted Sites icon is selected and click Custom Level. The
Security Settings pop-up window appears.
d. Scroll down to Scripting section and select the Enabled option under Active
Scripting.
e. Click OK.
f. Click Apply.
For Mozilla Firefox browser:
a. From the Tools menu, click Options.
b. Click Content.
c. Select the Enable JavaScript check box.
d. Click OK.

HTTP Status 404 - /PV Error
Symptom

When trying to access HP vPV, you get the HTTP Status 404 - /PV Error message.

Cause

The message appears if the <INSTALLDIR>/www/webapps/PV directory is empty.

Resolution

Extract the Perf.war file again from <Install_Dir>/newconfig/PV to <Install_
dir>/www/webapps/PV. Run the command pv deploywar.

What are the log files available with HP vPV?
The following table lists the log files available with HP vPV:
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Compon
ent

Description

pvcd (PV pvcd daemon uses XPL tracing mechanism. A
Collectio default pvcdXPL.itc (trace configuration) is
n
available in /opt/OV/support directory.
Daemon)
To start the tracing, run
/opt/OV/support/ovtrccfg -app pvcd
-cf
/opt/OV/newconfig/conf/xpl/trc/pvc
dXPL.itc The XPL trace files are present at
/tmp/pvcd_*.trc.

Location
If tracing is enabled, /tmp/
directory contains the trace files
(use - ls /tmp/pvcd_*.trc)

To stop tracing, run
/opt/OV/support/ovtrccfg -app pvcd
-off
pvcd and pvconfig tools log important status
and error messages, if any, in System.txt.

/var/opt/OV/log/System.txt

vCenter and OpenStack collector status log file
/var/opt/OV/log/status.virtserver

/var/opt/OV/log/status.virtser
ver

KVM collector status log file

/var/opt/OV/log/status.kvm

XEN collector status log file

/var/opt/OV/log/tmp/status.xen

Database
Transacti
on

Vertica catalog file to view database
transactions

/var/opt/OV/databases/pv/catal
og/pv/v_pv_node0001_
catalog/vertica.log

User
Interface

Local trace and log messages are logged in
pvtrace.0.txtand ovpm.0.log

/var/opt/OV/log

Collector
s
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Virtual Appliance
The RPMs packaged with the HP vPV Virtual Appliance are as follows:
l

setup-2.8.14-20.el6.noarch

l

basesystem-10.0-4.el6.noarch

l

tzdata-2012j-1.el6.noarch

l

glibc-common-2.12-1.107.el6.x86_64

l

ncurses-libs-5.7-3.20090208.el6.x86_64

l

libattr-2.4.44-7.el6.x86_64

l

zlib-1.2.3-29.el6.x86_64

l

audit-libs-2.2-2.el6.x86_64

l

popt-1.13-7.el6.x86_64

l

db4-4.7.25-17.el6.x86_64

l

nspr-4.9.2-1.el6.x86_64

l

bzip2-libs-1.0.5-7.el6_0.x86_64

l

libselinux-2.0.94-5.3.el6.x86_64

l

sed-4.2.1-10.el6.x86_64

l

glib2-2.22.5-7.el6.x86_64

l

gawk-3.1.7-10.el6.x86_64

l

sqlite-3.6.20-1.el6.x86_64

l

libxml2-2.7.6-8.el6_3.4.x86_64

l

libstdc4.4.7-3.el6.x86_64

l

dbus-libs-1.2.24-7.el6_3.x86_64

l

grep-2.6.3-3.el6.x86_64
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l

findutils-4.4.2-6.el6.x86_64

l

cyrus-sasl-lib-2.1.23-13.el6_3.1.x86_64

l

libblkid-2.17.2-12.9.el6.x86_64

l

keyutils-libs-1.4-4.el6.x86_64

l

libgssglue-0.1-11.el6.x86_64

l

libgpg-error-1.7-4.el6.x86_64

l

vim-minimal-7.2.411-1.8.el6.x86_64

l

checkpolicy-2.0.22-1.el6.x86_64

l

sysvinit-tools-2.87-4.dsf.el6.x86_64

l

perl-Pod-Escapes-1.04-129.el6.x86_64

l

perl-Module-Pluggable-3.90-129.el6.x86_64

l

perl-libs-5.10.1-129.el6.x86_64

l

pth-2.0.7-9.3.el6.x86_64

l

keyutils-1.4-4.el6.x86_64

l

grubby-7.0.15-3.el6.x86_64

l

upstart-0.6.5-12.el6.x86_64

l

libusb-0.1.12-23.el6.x86_64

l

nss-softokn-3.12.9-11.el6.x86_64

l

xz-lzma-compat-4.999.9-0.3.beta.20091007git.el6.x86_64

l

MAKEDEV-3.24-6.el6.x86_64

l

net-tools-1.60-110.el6_2.x86_64

l

tar-1.23-11.el6.x86_64

l

pinentry-0.7.6-6.el6.x86_64

l

e2fsprogs-libs-1.41.12-14.el6.x86_64

l

which-2.19-6.el6.x86_64

l

diffutils-2.8.1-28.el6.x86_64
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l

dash-0.5.5.1-4.el6.x86_64

l

groff-1.18.1.4-21.el6.x86_64

l

coreutils-libs-8.4-19.el6.x86_64

l

cracklib-2.8.16-4.el6.x86_64

l

coreutils-8.4-19.el6.x86_64

l

module-init-tools-3.9-21.el6.x86_64

l

redhat-logos-60.0.14-12.el6.centos.noarch

l

libpciaccess-0.13.1-2.el6.x86_64

l

rpcbind-0.2.0-11.el6.x86_64

l

nss-3.14.0.0-12.el6.x86_64

l

nss-tools-3.14.0.0-12.el6.x86_64

l

libuser-0.56.13-5.el6.x86_64

l

pciutils-libs-3.1.10-2.el6.x86_64

l

mingetty-1.08-5.el6.x86_64

l

ustr-1.0.4-9.1.el6.x86_64

l

libffi-3.0.5-3.2.el6.x86_64

l

newt-0.52.11-3.el6.x86_64

l

ca-certificates-2010.63-3.el6_1.5.noarch

l

python-libs-2.6.6-36.el6.x86_64

l

libssh2-1.4.2-1.el6.x86_64

l

curl-7.19.7-35.el6.x86_64

l

rpm-4.8.0-32.el6.x86_64

l

python-pycurl-7.19.0-8.el6.x86_64

l

gnupg2-2.0.14-4.el6.x86_64

l

pygpgme-0.1-18.20090824bzr68.el6.x86_64

l

yum-metadata-parser-1.1.2-16.el6.x86_64
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l

yum-plugin-fastestmirror-1.1.30-14.el6.noarch

l

bind-libs-9.8.2-0.17.rc1.el6.x86_64

l

fipscheck-lib-1.2.0-7.el6.x86_64

l

kbd-misc-1.15-11.el6.noarch

l

policycoreutils-2.0.83-19.30.el6.x86_64

l

iproute-2.6.32-23.el6.x86_64

l

util-linux-ng-2.17.2-12.9.el6.x86_64

l

udev-147-2.46.el6.x86_64

l

plymouth-0.8.3-27.el6.centos.x86_64

l

dracut-004-303.el6.noarch

l

rsyslog-5.8.10-6.el6.x86_64

l

cyrus-sasl-2.1.23-13.el6_3.1.x86_64

l

cronie-anacron-1.4.4-7.el6.x86_64

l

crontabs-1.10-33.el6.noarch

l

nfs-utils-1.2.3-36.el6.x86_64

l

selinux-policy-3.7.19-195.el6.noarch

l

kernel-firmware-2.6.32-358.el6.noarch

l

dhclient-4.1.1-34.P1.el6.centos.x86_64

l

system-config-firewall-base-1.2.27-5.el6.noarch

l

bfa-firmware-3.0.3.1-1.el6.noarch

l

iwl100-firmware-39.31.5.1-1.el6.noarch

l

b43-openfwwf-5.2-4.el6.noarch

l

aic94xx-firmware-30-2.el6.noarch

l

iwl1000-firmware-39.31.5.1-1.el6.noarch

l

authconfig-6.1.12-13.el6.x86_64

l

gettext-0.17-16.el6.x86_64
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l

grub-0.97-81.el6.x86_64

l

wget-1.12-1.8.el6.x86_64

l

passwd-0.77-4.el6_2.2.x86_64

l

audit-2.2-2.el6.x86_64

l

acl-2.2.49-6.el6.x86_64

l

ql2400-firmware-5.08.00-1.el6.noarch

l

ql2100-firmware-1.19.38-3.1.el6.noarch

l

libertas-usb8388-firmware-5.110.22.p23-3.1.el6.noarch

l

ql2500-firmware-5.08.00-1.el6.noarch

l

zd1211-firmware-1.4-4.el6.noarch

l

rt61pci-firmware-1.2-7.el6.noarch

l

ql2200-firmware-2.02.08-3.1.el6.noarch

l

ipw2100-firmware-1.3-11.el6.noarch

l

ipw2200-firmware-3.1-4.el6.noarch

l

vmware-studio-vami-tools-2.6.0.0-631426.x86_64

l

vmware-studio-vami-servicebase-2.6.0.0-631426.x86_64

l

vmware-studio-vami-service-system-2.6.0.0-0.x86_64

l

vmware-studio-vami-service-oaconfig-1.0.0.0-0.x86_64

l

vmware-studio-appliance-config-2.6.0.0-130820235403.noarch

l

vmware-studio-vami-login-2.6.0.0-631426.x86_64

l

libgcc-4.4.7-3.el6.x86_64

l

filesystem-2.4.30-3.el6.x86_64

l

ncurses-base-5.7-3.20090208.el6.x86_64

l

nss-softokn-freebl-3.12.9-11.el6.x86_64

l

glibc-2.12-1.107.el6.x86_64

l

bash-4.1.2-14.el6.x86_64
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l

libcap-2.16-5.5.el6.x86_64

l

info-4.13a-8.el6.x86_64

l

libcom_err-1.41.12-14.el6.x86_64

l

chkconfig-1.3.49.3-2.el6.x86_64

l

libacl-2.2.49-6.el6.x86_64

l

nss-util-3.14.0.0-2.el6.x86_64

l

libsepol-2.0.41-4.el6.x86_64

l

shadow-utils-4.1.4.2-13.el6.x86_64

l

gamin-0.1.10-9.el6.x86_64

l

readline-6.0-4.el6.x86_64

l

xz-libs-4.999.9-0.3.beta.20091007git.el6.x86_64

l

libidn-1.18-2.el6.x86_64

l

file-libs-5.04-15.el6.x86_64

l

tcp_wrappers-libs-7.6-57.el6.x86_64

l

pcre-7.8-6.el6.x86_64

l

lua-5.1.4-4.1.el6.x86_64

l

bzip2-1.0.5-7.el6_0.x86_64

l

libuuid-2.17.2-12.9.el6.x86_64

l

expat-2.0.1-11.el6_2.x86_64

l

krb5-libs-1.10.3-10.el6.x86_64

l

elfutils-libelf-0.152-1.el6.x86_64

l

libtirpc-0.2.1-5.el6.x86_64

l

libselinux-utils-2.0.94-5.3.el6.x86_64

l

cpio-2.10-11.el6_3.x86_64

l

gdbm-1.8.0-36.el6.x86_64

l

perl-version-0.77-129.el6.x86_64
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l

perl-Pod-Simple-3.13-129.el6.x86_64

l

perl-5.10.1-129.el6.x86_64

l

libgcrypt-1.4.5-9.el6_2.2.x86_64

l

dbus-glib-0.86-5.el6.x86_64

l

libnih-1.0.1-7.el6.x86_64

l

gmp-4.3.1-7.el6_2.2.x86_64

l

file-5.04-15.el6.x86_64

l

xz-4.999.9-0.3.beta.20091007git.el6.x86_64

l

libutempter-1.1.5-4.1.el6.x86_64

l

procps-3.2.8-25.el6.x86_64

l

psmisc-22.6-15.el6_0.1.x86_64

l

db4-utils-4.7.25-17.el6.x86_64

l

libss-1.41.12-14.el6.x86_64

l

m4-1.4.13-5.el6.x86_64

l

libgomp-4.4.7-3.el6.x86_64

l

binutils-2.20.51.0.2-5.36.el6.x86_64

l

ncurses-5.7-3.20090208.el6.x86_64

l

less-436-10.el6.x86_64

l

gzip-1.3.12-18.el6.x86_64

l

cracklib-dicts-2.8.16-4.el6.x86_64

l

pam-1.1.1-13.el6.x86_64

l

hwdata-0.233-7.9.el6.noarch

l

plymouth-scripts-0.8.3-27.el6.centos.x86_64

l

cvs-1.11.23-15.el6.x86_64

l

logrotate-3.7.8-16.el6.x86_64

l

nss-sysinit-3.14.0.0-12.el6.x86_64
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l

openldap-2.4.23-31.el6.x86_64

l

libcap-ng-0.6.4-3.el6_0.1.x86_64

l

ethtool-3.5-1.el6.x86_64

l

libevent-1.4.13-4.el6.x86_64

l

libsemanage-2.0.43-4.2.el6.x86_64

l

slang-2.2.1-1.el6.x86_64

l

plymouth-core-libs-0.8.3-27.el6.centos.x86_64

l

openssl-1.0.0-27.el6.x86_64

l

python-2.6.6-36.el6.x86_64

l

libcurl-7.19.7-35.el6.x86_64

l

rpm-libs-4.8.0-32.el6.x86_64

l

rpm-python-4.8.0-32.el6.x86_64

l

python-urlgrabber-3.9.1-8.el6.noarch

l

gpgme-1.1.8-3.el6.x86_64

l

newt-python-0.52.11-3.el6.x86_64

l

python-iniparse-0.3.1-2.1.el6.noarch

l

yum-3.2.29-40.el6.centos.noarch

l

mysql-libs-5.1.66-2.el6_3.x86_64

l

fipscheck-1.2.0-7.el6.x86_64

l

centos-release-6-4.el6.centos.10.x86_64

l

iptables-1.4.7-9.el6.x86_64

l

iputils-20071127-16.el6.x86_64

l

initscripts-9.03.38-1.el6.centos.x86_64

l

libdrm-2.4.39-1.el6.x86_64

l

kbd-1.15-11.el6.x86_64

l

dracut-kernel-004-303.el6.noarch
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l

openssh-5.3p1-84.1.el6.x86_64

l

postfix-2.6.6-2.2.el6_1.x86_64

l

cronie-1.4.4-7.el6.x86_64

l

nfs-utils-lib-1.1.5-6.el6.x86_64

l

iptables-ipv6-1.4.7-9.el6.x86_64

l

dhcp-common-4.1.1-34.P1.el6.centos.x86_64

l

kernel-2.6.32-358.el6.x86_64

l

selinux-policy-targeted-3.7.19-195.el6.noarch

l

openssh-server-5.3p1-84.1.el6.x86_64

l

iwl5150-firmware-8.24.2.2-1.el6.noarch

l

iwl6050-firmware-41.28.5.1-2.el6.noarch

l

iwl6000g2a-firmware-17.168.5.3-1.el6.noarch

l

iwl6000-firmware-9.221.4.1-1.el6.noarch

l

bind-utils-9.8.2-0.17.rc1.el6.x86_64

l

man-1.6f-32.el6.x86_64

l

libxml2-python-2.7.6-8.el6_3.4.x86_64

l

gdb-7.2-60.el6.x86_64

l

efibootmgr-0.5.4-10.el6.x86_64

l

sudo-1.8.6p3-7.el6.x86_64

l

e2fsprogs-1.41.12-14.el6.x86_64

l

attr-2.4.44-7.el6.x86_64

l

iwl5000-firmware-8.83.5.1_1-1.el6_1.1.noarch

l

ivtv-firmware-20080701-20.2.noarch

l

xorg-x11-drv-ati-firmware-6.99.99-1.el6.noarch

l

atmel-firmware-1.3-7.el6.noarch

l

iwl4965-firmware-228.61.2.24-2.1.el6.noarch
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l

iwl3945-firmware-15.32.2.9-4.el6.noarch

l

rt73usb-firmware-1.8-7.el6.noarch

l

ql23xx-firmware-3.03.27-3.1.el6.noarch

l

rootfiles-8.1-6.1.el6.noarch

l

vmware-studio-init-2.6.0.0-130820235404.noarch

l

vmware-studio-vami-cimom-2.6.0.0-631426.x86_64

l

vmware-studio-vami-service-core-2.6.0.0-0.x86_64

l

vmware-studio-vami-service-network-2.6.0.0-0.x86_64

l

vmware-studio-vami-service-update-2.6.0.0-0.x86_64

l

vmware-studio-vami-lighttpd-2.6.0.0-631426.x86_64
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:
Feedback on Installation Guide (Virtualization Performance Viewer 2.20)
Just add your feedback to the email and click send.
If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to docfeedback@hp.com.
We appreciate your feedback!
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